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NOTICE 

All aspects of this instrument, including its design, functionality, and features, are subject 

to intellectual property protection. Unauthorized reproduction, distribution, or use of this 

instrument or any of its components is prohibited, violations will be prosecuted to the full 

extent of the Law. 

Q Biotech Corp reserves the right to modify its products and services at any time. This 
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ensure accuracy, Q Biotech Corp assumes no liability for errors or omissions, or for any 

damages resulting from the use of this information. Q Biotech Corp assumes no liability 

for misuse of its products or software. 

Tygon is a trademark of Norton Co. Windows is a trademark of Microsoft Corporation. 
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1 OVERVIEW 

Inceptum™ is a fully automated personal chromatography system for purification of 

proteins, RNA, and DNA. The system utilized application specific and open cartridges to 

ensure that the fluid path is completely separated from the instrument. 

The Inceptum™ system consists of an instrument and two types of disposable cartridges, 

and a Windows™ computer (not included). Application-specific cartridges contain up to 

two columns and include all the necessary buffer solutions to perform purification of 

proteins using specific chromatography.  

The application-specific cartridges can be utilized for the following types of purification:  

• Affinity purification of antibodies using protein G binding, followed by buffer 

exchange into a neutral buffer, e.g. PBS.  

• Ni-NTA affinity purification of His-tagged proteins. 

• Buffer exchange cartridges to replace buffer using desalting columns. The standard 

buffer is PBS, but this can be customized for each order.  

• Affinity purification of GST-tagged proteins. 

• Affinity purification of MBP-tagged proteins.  

• Ion-exchange cartridges that contain an IEX column and buffers for NaCl gradient 

elution.  

• Custom cartridges with custom configurations of up to two columns and up to three 

buffer solutions.   

The open cartridges provide all the necessary external connections to attach up to two 

columns and up to three buffer solutions, as well as a sample inlet. The sizes of the 

columns and volumes of buffer solutions are limited only by the chosen application 

protocol. Inceptum™ provides a disposable, easy to change, fluid drive and measurement 

system for user-defined purification.  
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2 FEATURES 

• Provides easy to use, fully automatic, rapid DNA, RNA, and protein purification. 

• Platform provides integrated data capture (UV and conductivity) and complete 

control of fluidics components. 

• Gradient elution and exchange of proteins or nucleic acids into a convenient buffer 

during the purification process, in the same purification run. 

• Utilizes chemistries such as affinity, ion exchange, Ni-NTA, and other water based 

chemistries. 

• Flow rate capabilities range between 1-40 mL/min. 

• Isocratic or gradient flow with two inputs 

• Design prevents cross-contamination. 

• Compatible with external fraction collector 

• Two column system 

• Minimal setup time 

• Low maintenance design with easy setup and minimal maintenance.   

• Fully disposable fluidics path. No wetted components are inside of the instrument.   
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3 INCEPTUM SHIPPING CONTENTS 

The shipping box includes the following:  

• Inceptum™ Main Instrument 

• AC Power Supply and Cable 

• USB C cable 

• USB Flash Drive with software 

4 UNPACKING AND INSTALLATION 

4.1. UNPACKING  

When opening the box, carefully inspect it for any damage that may have occurred during 

shipment. Severe damage to the container may indicate that the contents have been 

damaged during shipping. If you suspect that there are any damaged or missing 

components, immediately contact Q-Biotech.  

After opening the box, carefully remove the shaped foam packaging. The top of the 

instrument should be visible, along with the bag and box containing the cables and power 

supply. Remove these and gently lift the instrument from the box.  Hold the instrument by 

the sides when lifting, do not use the slot as a handle to avoid damaging cartridge 

interface contacts.  

 

Figure 1. Power supply and USB-C cable included in the box.   

4.2. INSTALLATION 

The Inceptum™ can be installed and used on a benchtop, a mobile cart or other location 

which provides a stable platform for operation.  The instrument can be operated at 
ambient temperature or in a refrigerated environment meeting specifications (see Section 

6. Specifications).   
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A computer running Windows™ 10 or later is required to utilize Inceptum™ software.  The 

software must be preinstalled before use. The software is provided with the instrument as 
an installable executable on an included USB drive. It can also be downloaded from 

https://q-biotech.com/inceptum.  

Installation steps:  

• Place instrument on a benchtop, away from direct sunlight or heat sources.   

• Connect the power supply to the instrument 

• Plug in the power cable to 100-240VAC, 50-60 Hz outlet.  

• Connect the provided USB cable from the USB-C port on the instrument to the USB 

port on the computer.  

• Turn on the instrument using the power switch on the back of the instrument.  

  

https://q-biotech.com/inceptum
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5 PHYSICAL DESCRIPTION 

5.1. FRONT PANEL 

 

Figure 2. Inceptum, viewed from the front.   

Cartridge slot provides a mechanical, optical and electrical interface to a cartridge (Section 5.1.1), 

the indicator lights reflect the position of valves, status of pump and cartridge  (Section 5.1.2).   

5.1.1. CARTRIDGE SLOT 

Insert the cartridge in this slot. This slot is configured for open cartridges and application 

cartridges.  When moving the instrument, do not use cartridge slot as a hand-hold.  Doing 

so might result in damage to interface pins located on the back of the slot. 



Physical Description 

6 

5.1.2. INDICATOR LIGHTS 

 

 

Figure 3. Indicator lights as seen in an idle state with no cartridge inserted. 

The indicator lights on the front panel of Inceptum™ allow you to monitor the status and 

process of the instrument. Each light is labeled for clear understanding of the status. From 

the top, the first two lights represent the columns, the next five are the valves, and the 

lower two lights represent the pump and cartridge. For more detailed information about 

the configuration of the columns, valves, and pumps, please refer to figure 6. 

Table 1. Valve position as shown by the color of the indicator light.  

Valve Position Indicator Lights 

1-2 cyan 

1-3 green 

1-2-3 yellow 

2-3 blue 
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Table 2.  Pump status indicator light.  

Pump Status Indicator Lights 

Running green 

Stopped blue 

Pump Error red 

 

The cartridge status is indicated by the bottom light. 

Table 3.  Cartridge status indicator light. 

Cartridge Status Indicator Lights 

No Cartridge Detected red 

Cartridge Detected green 

Calibration Failed yellow 
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5.2. REAR PANEL 

 

Figure 4. Rear panel connections and controls. 

 

Power Switch: Turns the instrument on or off. 

Power Input: Insert the power cable here.  Use only power supply provided with 

the instrument.  

External I/O: Connects to the fraction collector (optional) 
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USB Input: Connects to the computer and software. Use USB-C cable provided 

with the instrument.  If a replacement is necessary, most USB-C data cables will work.  

USB-C cables designed for charging only, often do not have data connections and will not 

work. 

 

 

 

6 GRAPHICAL USER INTERFACE  

The main window of the Inceptum™ software is shown in Figure 5.   

 

Figure 5. Elements of software user interface.  

Data file toolbar:  Here you can open and save data files. This is also accessible 
through the “File” menu.  

Batch protocol toolbar:  Here you can open, save, or edit batch files. This is also 
accessible through the “File” menu.  

Instrument connectivity toolbar:  This allows you to select the port and connection 

to the Inceptum™ instrument. This is also accessible through the “Options” menu.  
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Batch control toolbar:  Here you can start or stop the batch execution. This is also 
accessible through the “Run” menu. 

Detector and pump control toolbar:  From here you can start/stop the data capture 
(detector), set zero for the absorbance (zero detector), as well as start/stop the pump. 

Pump commands are also accessible through the “Run” menu. 

Fraction collector toolbar:  If you are using a fraction collector, you can start, stop, 
or pause the fraction collector or command the collector to advance to the next fraction. 

Batch protocol editor window:  Right click to add or remove rows.  

System view:  This shows the fluidics configuration of the cartridge and the current 
status of the instrument.  Right click to change parameters of all elements on the 
diagram.  

Data log window:  This shows low-level events and data exchanged between the 
instrument and the software. 

Chromatogram plot:  Right click to reset zoom, shift+left click to select zoom area, 

ctrl-wheel to zoom in/out, and hold the left mouse button to pan the chart.  

 These are docking windows which can be repositioned, resized, and docked 

into the tabbed left area. If you close a window, you can reopen it by right-clicking on the 

toolbar and selecting the appropriate checkbox for the window.  

  



Graphical user interface 

11 

6.1. BATCH EDITOR WINDOW 

The primary mode of operation for Inceptum™ is the batch method, where the purification 

is performed automatically using a pre-defined protocol. You can create a new batch or 

open an existing batch through the toolbar. Manual control can be performed for an initial 

instrument setup after inserting a new cartridge.  The manual control can also be useful 

for an open cartridge, or for customized operation of an application cartridge. The batch 

editor window facilitates the creation of a new batch method or the editing of an existing 

batch method.  

Commands are executed sequentially, so the next command is executed upon the 

completion of the previous command. You can add or remove commands in the editor by 

clicking the right mouse button in the window. Commands can be appended to the current 

batch by clicking on the Add Row button. It is best practice to have all required 

commands entered prior to protocol execution. For convenience, there is also standard 

cut, copy, and paste functionality through icons in the toolbar.  

Commands can control the instrument directly (e.g. pump, valve, and detector 

commands), provide set time delays, or conditional commands which activate only when a 

specific condition is met (e.g. OD crosses threshold). Conditional commands require 

operational time limits. An individual comment can be set for each command. An example 

of the batch editor window is shown below. 

 

Figure 6. Batch editor window. 
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6.2. BATCH COMMANDS 

Batch commands contain the following elements:  

Subsystem (device): This defines which device this command relates to. This includes 

the pump, valve, detector, wait timer etc.  

Action: This is the relevant parameter or action for the selected device. E.g. for the pump 

you can select parameters such as flow (flow rate), fracA, etc.  

Value: Parameter values can be entered in several ways: Numeric, selected using a 

spinbox, predefined values selected using the dropdown box, or text that can be entered 

into the cell.  

Units: If applicable, this shows units for the parameter value.  

 

Table 4. Pump commands 

Action Type of Value Units Notes 

flow numeric mL/min Set pump flow rate. 

fracA numeric % Set fraction of pump A in the isocratic flow 

fracA_start numeric % Set fraction of pump A at the beginning of gradient flow 

fracA_end numeric % Set fraction of pump A at the end of gradient flow 

gradientTime numeric min Set gradient time.  Combination of fracA at the start and the end of the gradient 
and gradient time determines the rate of change of pump A fraction.  

isocratic none   Set pump to isocratic flow (constant fraction of pump A) 

gradient none   Set pump to gradient flow (fraction of pump A will change linearly from 
farcA_start to fracA_end during the gradientTime). 

on none   Start pump 

off none   Stop pump 

calibrate none   Calibrate pump.  This command is typically not used.   

In order to set pump for gradient operation, first, stop the pump.  Next, set flow 

parameters (fracA_start, fracA_end, gradientTime etc) and start the pump (pump on).  

The next command in the batch should be time delay (wait, time) to allow the gradient to 

be completed.   

Table 5. Valve Commands 

Action  Type of Value Units Notes 

set combobox   Select which outlet of the valve are connected 
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Table 6. Detector Commands 

Action Type of Value Units Notes 

zero none   Set UV absorbance to zero.   

on none   Turn reporting of the UV and conductivity measurement on.  This command is 
executed automatically at the beginning of a batch 

off none   Turn reporting of the UV and conductivity measurement off.  This command is 
executed automatically at the end of a batch. 

 

Table 7. Column Commands 

Action Type of Value Units Notes 

Switch combobox   Change valves position to switch the column in the flow or out of the flow. 

Name string   Set name of the column 

Volume numeric mL Set column volume 

max flow rate numeric mL/min Set maximum flow rate through the column.  

 

Table 8. Bottle Commands 

Action Type of Value Units Notes 

name string   Set buffer name 

volume numeric mL Set initial volume of the container 

 

Table 9.Sample Input Commands 

Action Type of Value Units Notes 

volume numeric mL Set volume of the sample container 

 

Table 10.Sample Collect Commands 

Action Type of Value Units Notes 

volume numeric mL Set maximum volume of the collection container 

 

Table 11. Waste Commands 

Action Type of Value Units Notes 

volume numeric mL Set maximum volume of the waste container 
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Table 12. Wait and Event Commands 

Action Type of Value Units Notes 

time numeric min Wait until the set time has elapsed.  

OD> numeric au Wait until OD is greater than the threshold.  This setting also has an expiration 
time.  When the expiration time is reached, the program execution continues 
even if the OD trigger is not reached. 

OD< numeric au Wait until OD is less than the threshold.  This setting also has an  expiration 
time.  When the expiration time is reached, the program execution continues 
even if the OD trigger is not reached. 

Conductivity> numeric mS Wait until Conductivity is greater than the threshold.  This setting also has an 
expiration time.  When the expiration time is reached, the program execution 
continues even if the Conductivity trigger is not reached. 

Conductivity< numeric mS Wait until Conductivity is less than the threshold.  This setting also has an 
expiration time.  When the expiration time is reached, the program execution 
continues even if the Conductivity trigger is not reached. 

 

Table 13. Chart Control Commands 

Action Type of Value Units Notes 

marker string   Place marker on a chart.  Useful to indicate specific steps on the chart. 

 

Table 14. Fraction Collector Control Commands 

Action Type of Value Units Notes 

start none   Start fraction collection.  Fraction numbers start from 1. 

stop none   Stop fraction collection 

continue none   Continue fraction collection, fraction numbers continue.  

duration numeric sec Set time duration of a fraction.   

advance none   Advance fraction collector to the next fraction immediately. 
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6.3. SYSTEM VIEW AND CONTROL 

“System View” displays the current instrument state and allows the operator to manually 

control the system state (See Figure 7).  

Figure 7. System view window.  
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System view operations: 

• Use Ctrl+mouse wheel to zoom in and out. 

• Use mouse wheel or horizontal and vertical scroll bars to move the view around.   

• Right-click on a subsystem (pump, valve, column, etc.) to change the parameters 

of that subsystem. 

The manual control using the System View is useful for priming and setup of the cartridge.  

Typically, the chromatography will be performed using a batch protocol.  However, the 

System View allows to perform a chromatography in a manual mode.  In addition, if a 

manual adjustment to the currently executed protocol is necessary, it can be done using 

System View.   

6.4. SYSTEM CONFIGURATION AND INSTRUCTIONS 

Configuration depends on the intended cartridge use.  

Application cartridges have pre-configured protocols that can be utilized directly or 

modified for customized use.   

Open cartridges require manual setup or a custom batch protocol.  

6.5. CONNECTING EXTERNAL FRACTION COLLECTOR 

Inceptum™ can interface with an external fraction collector (not included). If using a 

fraction collector, connect the I/O of the fraction collector to the back panel (See Error! 

Reference source not found. and Table 15). 
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7 OPERATION 

1 Open the Inceptum™ software by clicking on the software icon on the desktop or from 

the taskbar or start menu. 

2 Remove the cartridge from its packaging and check the valve orientation.  The valves 

have to be oriented as shown in Figure 8 for correct operation.   

 

Figure 8.  Correct Valve orientation on a cartridge.   

A) Open cartridge.  B) Application cartridge.  Flow select valve orientation depends on the 

cartridge, and it’s use, see cartridge “Instructions for Use”.  
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3 Insert the cartridge into the slot on the instrument (Figure 9). The cartridge should 
insert readily into the slot. DO NOT force the cartridge into the slot. 

Figure 9.  Insert cartridge into the instrument slot as shown above.   

The cartridge should slide into the slot without excessive force.  If there is difficulty inserting the 

cartridge, check the correct orientation of the valves (see previous step) or turn instrument off, 

then on to realign valves. 

3.1 If there is difficulty inserting the cartridge, visually verify that the slot is not 
obstructed. If the valve slots are misaligned, turn off the instrument, wait 5 

seconds, and turn it back on. This will reset the valve slots to the correct 
orientation. Any previously entered batch settings will be preserved by the 
software.   

4 Following insertion, the instrument will detect the cartridge, and the bottom light on 
the front panel will turn green. Autocalibration will begin. The autocalibration progress 

bar (see Figure 10) must reach 100% before the cartridge can be used. You will not 
be able to run any purifications without a successful autocalibration. You may 
manually calibrate the pump from the ‘Run’ dropdown menu in the toolbar to manually 

operate the pump through the software, though you will still be unable to carry out 
protocol driven purifications with this type of calibration. If the autocalibration fails, 

remove the cartridge and attempt reinsertion after 3 seconds have elapsed.  If the 
autocalibration fails again, the cartridge is not operational and needs to be replaced.  
Please contact customer service for replacement options. 
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Figure 10. Pump calibration progress window.   

When pump calibration is successfully completed, close the window by pressing “OK”.  The 

instrument is ready for use. 

5 To start new purification run, select  ‘Start new purification run’ from the toolbar or 
the ‘File’ dropdown menu. This will open the New Run Parameters window (Figure 11) 

which contain selection of single or multi-run, Purification information, data and batch 
protocol files. Multi-run enables performing the same purification multiple times 

without manual intervention. 

6 If an application cartridge is inserted, the purification batch will be automatically 
loaded.  Users can utilize this batch method, modify it, or load a new batch method.  

For an open cartridge, a user-defined protocol must be used. 

7 Clicking the ‘select’ next to the info bar will open the purification info window (Figure 

12). Here you can type any notes on the purification you are running, as well as 
specifying who is operating the system and any reference you choose.   
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8 Clicking the ‘select’ next to the data file bar will open your computers file explorer for 

you to select where your purification will be saved (Figure 13). You may also select 

‘create’ and the system will automatically create a new file based on your reference 

entry in the purification info window and directory you select.  

Figure 11. Select run parameters.   

 

Figure 12.  Purification information window. 



Operation 

21 

 

Figure 13.  Dialog box to select new data file name.   

 

9 Clicking the ‘select’ next to the batch file bar will open your computer’s file explorer to 
select batch protocol file. It is not necessary to have previously opened the protocol in 

the software. Only the selected protocol from the file will be used for the purification. 

10 Start the purification using menu ‘Run/Start run’ or toolbar ‘ ’ (see Figure 14Error! 
Reference source not found.). You will not be able to operate the pump manually 

while performing a protocol driven purification.   

 

Figure 14.  Options to start purification.  

A) from menu Run/Start Run, or, B) from toolbar (right arrow button).   

 

11 During the execution of the protocol for each “wait” condition, a timer will appear at 
the bottom of the window (see Figure 15). This timer indicates the estimated time 
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until completion for each timed delay step. The progress of the batch protocol can be 
monitored in the batch window, and the current step will be highlighted. 

 

Figure 15. Progress bar at the bottom of the main window showing time remaining in the current 

step. 

The status of the process can also be observed through the data log window and system 

view in the software. The batch process can be paused or halted through the batch control 

toolbar (Figure 5, ) 

12 The run can be paused or halted using “Stop current protocol” action on tollbar (see 

Figure 5. ), or “Run/Stop Protocol” menu.  To re-start, abort or continue the run, select 

“Run/Start Run” menu.  Select action you would like in the Dialog window (see Figure 16) 

Note: When the protocol is paused, the system maintains the current status.  For 

example, if the pump was running, it will continue to run.  Manual control of the 

valves and the pump is enabled through system view window.  When the run is 

continued, the system will continue with any manual changes made.  The delay 

timer will continue counting during the pause.   

Figure 16. Options to continue paused protocol. 

 

12 When the process is complete, a notification will appear confirming completion (see 
Figure 17. If using an open cartridge, make sure that the fluid connections are 

secured (either disconnected or pinched off) in order to prevent accidental fluid flow 
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and mixing once the cartridge is disengaged. All tubing must be secured before 
ejecting the cartridge. When using an automatic cartridge this is not necessary. 

Once this is complete, press 'eject cartridge' on the toolbar. The instrument will 

automatically return the valves and pumps to their default positions. The instrument will 

disengage from the cartridge and the software will provide a prompt to remove the 

cartridge when ready.  

Figure 17. A dialog window indicating batch completion. 

13 Remove the cartridge and refrigerate for reuse as necessary. Do not leave the 

cartridge in the instrument when not in use.  

14 In order to print a purification report Select menu File/Print report.  The report can be 
printed to any printer installed on the computer, including “print to pdf”.  An example 

of the report is shown in Figure 18. 
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Figure 18.  Example of printed report.   

The header contains all information entered in the new file dialog box.   

 

  



Maintenance and Troubleshooting 

25 

5 MAINTENANCE AND TROUBLESHOOTING  

The cartridge should insert easily into the slot. If there is difficulty inserting the cartridge, 

visually verify that the cartridge slot is not obstructed, then turn off the instrument, wait 5 

seconds, and turn it back on  

If the valves on the cartridge are misaligned, manually adjust the valves, see Section 7, 

turn off the instrument, wait 5 seconds, and turn it back on. 

Inceptum™ operates on a closed system with a sealed interior and is designed to prevent 

overflow. If the housing or the cartridge requires cleaning, wipe the surface with a 70% 

ethanol solution. Do not spray the instrument with the solution, wipe only.  

If the software cannot connect to the instrument, make sure the USB-C cable is fully 

inserted.  If the problem persists, remove and re-insert USB-C cable.  When computer 

sound is enabled, Windows will provide audible notification of removal and insertion of the 

cable.   
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6 SPECIFICATIONS 

Instrument  

Flow rate 

(flow rate depends on cartridge) 

0 – 50 mL/min 

Max Pressure 15 psi (103 kPa) 

Number of independent pumps 2 

Wetted materials No fluid contact with disposable cartridge 

Optical density range (@275 nm) 0 – 3,000 m.a.u. (0-3 OD275 @ 1 cm optical pathlength) 

OD stability < 0.5% CV after 15 min warmup 

Conductivity measurement 
range 

0 - 500 mS 

External operation Controlled through GUI software from a laptop/PC with USB-C 
serial connection. Windows 10 or later, 64-bit OS is required.  

External instrument control Can control external fraction collector using standard 
interface (connect TTL line to external ground to advance 
fraction, start/stop remote control). Programmable interface 
with 3 command lines 

 

Operational parameters 

Power consumption 60W max 

Input power 90-240V AC, 50/60 Hz 

Max internal voltage 12V 

Fusing No external fusing 

 

Environmental requirements 

Operating temp 2-40oC 

Storage temp 2-40oC 

Operating humidity Up to 90% RH, non-condensing 

Dimensions 10.5 x 10 x 11 in (w x d x h) 267x254x279 mm 
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Standard Cartridge 

Separation media Function specific, up to 2 columns, up to 20 mL each. 

Buffer capacity Up to 3 buffer solutions, up to 500 mL total volume 

External fluid connections Sample inject port, sample collect tube, external fraction 
collector outlet. Sample collect tube or external fraction 
collector outlet selected by manual valve prior to cartridge 
use). 

Wetted materials Silicone, polyethylene, Tygon, quartz, gold. 

 

Open Cartridge 

Separation media User provided, up to 2 columns, unlimited volume (external 
placement). 

Buffer capacity Unlimited, connection provided (luer-lock or slim-line sterile 
connector) 

Wetted materials Silicone, polyethylene, Tygon, quartz, gold. 
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10 REAR PANEL CONNECTOR INFORMATION 

The rear panel contains a terminal block for connecting to a fraction collector (Error! 

Reference source not found.).  The matching terminal block is produced by Phoenix 

Contact, part number 1902149 (https://www.phoenixcontact.com/en-

pc/products/printed-circuit-board-connector-fkct-25-5-st-508-1902149).   

Any fraction collector that accepts contact closure as a signal to advance to the next 

fraction can be used with Inceptum™ System.  Connect the control signal to Pin1 and 

ground to Pin 3 of the connector (Table 15). 

 

Figure 19. Connector to control an external fraction collector. 

The pin 1 is located at the left side of the connector, when viewed from the rear panel.   

 

Table 15. External fraction collector output signals.  

Pin Signal Type Active Description 

1 Advance 
fraction 

Pulse Low Output is TTL compatible and can withstand 
+15V.  Normally open. To advance fraction, 

this pin is connected to Ground (pin 3) for 
at least 100 µs.   

2 N/A    

3 Ground --   

4 N/A    

5 N/A    

 

  

https://www.phoenixcontact.com/en-pc/products/printed-circuit-board-connector-fkct-25-5-st-508-1902149
https://www.phoenixcontact.com/en-pc/products/printed-circuit-board-connector-fkct-25-5-st-508-1902149
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11   WARRANTY AND ORDERING INFORMATION 

The Inceptum™ System is warranted for one year against defects in 

materials and workmanship.  If any defects should occur during the warranty 

period, Q Biotech Corp will repair or replace the instrument at its discretion, 

without charge.  However, the following defects are specifically excluded:  

• Defects caused by improper operation 

• Repair or modification performed by an unauthorized personnel 

• Defects caused by using damaged or modified cartridges 

• Damage caused by deliberate or accidental misuse 

• Damage caused by disaster 

• Damage due to improper solvents or samples 

7.1. 11.1 WARRANTY INFORMATION 

Model I1001 

Serial Number _________________________________________________ 

Date of Delivery _________________________________________________ 

Warranty Period _________________________________________________ 

7.2. 11.2 ORDERING INFORMATION 

 

cat # Name 

I1001 Inceptum™ Chromatography system 

C1101 Inceptum™ Antibody purification cartridge 

C1103 Inceptum™ Open cartridge, standard 

Please contact us to customize cartridges (e.g. custom connectors or buffer solutions) or 

to request new cartridge types.   

 


